DI9040MPHC MIPI M-PHY
Conformance Test Application

Keysight D9040MPHC Software Version 2.60.5.0

Release Date: April 3, 2023

Requirements Category Microsoft Windows 10
(e.g., operating system):

Requirements Category 06.74.00402 (9000 Series, 90000 Series, 90000 X-Series,
(e.g., instrument software version): 90000 Q-Series, Z-Series),

11.50.00601 (UXR/UXR-B Series)

File Name: SetupInfMIPI_M-PHY02600005.exe
License: Please see the product data sheet on keysight.com
Modification

® Update Keysight License Manager b.

New Features

® Supports UXR-B Series oscilloscope.
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Keysight D9040MPHC Software Version 02.60.0000

Release Date: September 17, 2021

Requirements Category Microsoft Windows 10,

(e.g., operating system): Microsoft Windows 7

Requirements Category 06.73.00102 (9000 Series, 90000 Series, 90000 X-Series,
(e.g., instrument software version): 90000 @-Series, Z-Series),

11.30.00406 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02600000.exe

License: Please see the product data sheet on keysight.com

New Features

e Added support for new license subscription bundle.

Enhancements

e Added support for InfiniiSim HW Acceleration. Disabled the view for the InfiniiSim graph in
order to enable the HW Acceleration feature when running InfiniiSim in GMAX baseline.
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Keysight D9040MPHC Software Version 02.50.0000

Release Date: March 12, 2021

Requirements Category Microsoft Windows 10,

(e.g., operating system): Microsoft Windows 7

Requirements Category 06.55.00504 (9000 Series, 90000 Series, 90000 X-Series,
(e.g., instrument software version): 90000 Q-Series, Z-Series),

10.20.00501 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02500000.exe

License: Please see the product data sheet on keysight.com

New Features

- Added “Optional Screenshot” in configure tab. This option can enable/disable screenshot
to be taken during tests.

- Added new tests to the Universal Flash Storage (UFS) Host Controller Reference Clock test
group.

o TestID: 3008 - Reference Clock Random Jitter (RJ)
o TestID: 3009 - Reference Clock Deterministic Jitter (DJ)

- Updated UFS Clock Test Setup to add in “UFS Specification Version”. This option is used
to select the specification version of the tests, and the test list will be updated accordingly.

- Updated UFS Clock Test Setup to add in “Frequency Selection”. Choose the correct
frequency that corresponds to the UFS Reference Clock signal being tested.

Bug Fixes
- Replaced the SigTest template with the ones with correct CTLE settings.
- 1.1.4 VCM_LA_RT_TX test vertical scale now scales correctly to the signal amplitude.

- 1.1.9T_L2L_Skew test now reports absolute measured result, with the test limit changed
from range inclusive to max inclusive.

Known Issue

- When executing Test 1.1.6 TEYE, VDIF (C ) on Infiniium v10.20.00501 on UXR scope, this
test might get aborted without the memory depth upgrade option.

- Inloading projects created in MIPI MPHY version 02.30.0002, users might not append the
existing results.
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Keysight D9040MPHC Software Version 02.40.0000

Release Date: March 30, 2020

Requirements Category Microsoft Windows 10,

(e.g., operating system): Microsoft Windows 7

Requirements Category 06.55.00504 (9000 Series, 90000 Series, 90000 X-Series,
(e.g., instrument software version): 90000 Q-Series, Z-Series),

10.20.00501 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02400000.exe

License: Please see the product data sheet on keysight.com

Miscellaneous Notes
- NA

New Features

- Added Universal Flash Storage (UFS) Host Controller Reference Clock feature. This feature
requires “D9040MPHC” license.

o Added “UFS Clock Informative Test” configurable option(with remote name of
“UFSClockinformativeTestEnable”) in Setup tab. All UFS Reference Clock tests will be
enabled by checking this option.

o Added “UFS Reference Clock Probing Method” configurable option(with remote name
of “UFSRefClockProbingMethod”) in UFS Clock Test Setup window. This option is used
to specify the probing method for all UFS Reference Clock tests except Phase Noise
and Noise Floor Density tests.

o Added “Single-Ended (Ref Clock)” configurable option(with remote name of
“UFSRefClockChanSE”) in UFS Clock Test Setup window. This option is used to specify
the channel selection for all UFS Reference Clock tests except Phase Noise and Noise
Floor Density tests.

o Added “Phase Noise Measurement Method” configurable option(with remote name of
“UFSPhaseNoiseMeasurementMethod” in UFS Clock Test Setup window. This option is
used to specify the measurement method for UFS Phase Noise tests.

o Added “Phase Noise Source 1 (Ref Clock)” configurable option(with remote name of
“UFSRefClockPhaseNoiseSourcel” in UFS Clock Test Setup window. This option is
used to specify the channel for Reference Clock Phase Noise Source 1.

o Added “Phase Noise Source 2 (Ref Clock)” configurable option(with remote name of
“UFSRefClockPhaseNoiseSource2” in UFS Clock Test Setup window. This option is
used to specify the channel for Reference Clock Phase Noise Source 2.

- Added the following new tests to support UFS Host Controller Reference Clock tests.
o TestID: 3000 - Reference Clock Output High Voltage (VOH)
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Test ID: 3007 - Reference Clock Output Low Voltage (VOL)

Test ID: 3002 - Reference Clock Output Clock Rise Time (ToRise)
Test ID: 3003 - Reference Clock Output Clock Fall Time (ToFall)
Test ID: 3004 - Reference Clock Frequency Error (Ferror)

Test ID: 3005 - Reference Clock Duty Cycle (Tdc)

Test ID: 3006 - Reference Clock Phase Noise (N)

Test ID: 3007 - Reference Clock Noise Floor Density (Ndensity)

O O 0 O O O ©O

Added the UFS Host Controller Reference Clock configurable options in Configure tab.

o Added “Ref Clk Frequency, MHz” configurable option(with remote name of
“UFSPhaseNoiseMeasurementMethod”) in Configure tab. This option is used to specify
the frequency of UFS Host Controller Reference Clock signal.

o Added “Ref Clk VCCQ Source” configurable option(with remote name of
“VCCQSource_RefClk”) in Configure tab. This option is used to specify the source of
VCCQ reference voltage for VOH and VOL measurement.

o Added “Ref Clk VCCQ Voltage” configurable option(with remote name of “VCCA_Volt”)
in Configure tab. This option is used to specify the VCCQ reference voltage for VOH
and VOL measurement.

o Added “Ref Clk Sampling Rate, GSa/s” configurable option(with remote name of
“SRate_RefClk”) in Configure tab. This option is used to specify the sampling rate for all
UFS Reference Clock tests.

o Added “Ref Clk Memory Depth” configurable option(with remote name of
“SRate_RefClk”) in Configure tab. This option is used to specify the memory depth for
all UFS Reference Clock tests except Phase Noise and Noise Floor Density tests.

o Added “Termination Emulation” configurable option(with remote name of
“TermEmu_RefClk”) in Configure tab. This option is used to enable the proper
termination emulation for all UFS Reference Clock tests except Phase Noise and Noise
Floor Density tests.

o Added “UFS Butterworth Filter Cutoff Frequency(Hz)” configurable option(with remote
name of “UFSButterFiltCutoffFreq”) in Configure tab. This option is used to specify the
Butterworth filter cutoff frequency.

o Added “UFS Butterworth Filter Order(Hz)” configurable option(with remote name of
“UFSButterFiltOrder”) in Configure tab. This option is used to specify the Butterworth
filter order.

o Added “Ref Clk Phase Noise Sampling Rate, GSa/s” configurable option(with remote
name of “SRate_RefClk_PhaseNoise”) in Configure tab. This option is used to specify
the sampling rate for all UFS Reference Clock tests except Phase Noise and Noise
Floor Density tests.

o Added “Ref Clk Phase Noise Memory Depth” configurable option(with remote name of
“AcgPoints_RefClk_PhaseNoise”) in Configure tab. This option is used to specify the
memory depth for all UFS Reference Clock tests except Phase Noise and Noise Floor
Density tests.
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o Added “Ref Clk Phase Noise Integration Start Frequency, Hz” configurable option(with
remote name of “UFSPNStartFreq”) in Configure tab. This option is used to specify the
Phase Noise measurement start frequency.

o Added “Ref Clk Phase Noise Integration Stop Frequency, Hz” configurable option(with
remote name of “UFSPNStopFreq”) in Configure tab. This option is used to specify the
Phase Noise measurement stop frequency.

o Added “Ref Clk Phase Noise Floor Start Frequency, Hz” configurable option(with
remote name of “UFSPNFloorStartFreq”) in Configure tab. This option is used to
specify the Phase Noise Floor measurement start frequency.

o Added “Ref Clk Phase Noise Sources Deskew” configurable option(with remote name
of “UFSPNCorrelationDeskew”) in Configure tab. This option is used to enable the
deskew between Phase Noise Source 1 and Phase Noise Source 2.

Bug Fixes
- Updated test limit for Test 1.1.2 PSDCM for CTS v4.0 and v4.1.

- Fixed "Max Trials to Store Details" from 5 to 25.
Store Mode

During run, store details for WorstIT trials (up to 25)

Known issues

- When executing Test 1.1.6 TEYE, VDIF (C ) on Infiniium v10.20.00501 on UXR scope, this
test might get aborted without the memory depth upgrade option.

- Inloading projects created in MIPI MPHY version 02.30.0002, users might not append the
existing results.

Keysight D9040MPHC MIPI M-PHY Conformance Test Application Release Notes 6/32



ANV KEYSIGHT

Keysight D9040MPHC Software Version 02.30.0002

Release Date: August 27, 2019

Requirements category (e.g., operating system): Microsoft Windows 7,
Microsoft Windows 10

Requirements category (e.g., instrument software 06.40.01001 (9000 Series, 90000 Series, 90000 X-
version): Series, 90000 Q-Series, Z-Series),

10.11.04711 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02300002.exe

License: Please see the product data sheet on keysight.com

Miscellaneous Notes
- NA

New Features

- Added support for new export to repository feature where user can export test results to a
repository (such as a database). [File->Export Results...->Repository]

Bug Fixes
- Fixed typo on “SA_NT - Large Amplitude Unterminated Mode” in Setup tab.
- Fixed “Unable to find MarkerO” issue on Test 1.1.9 T_L2L_Skew test.
- Fixed remote access issue on N7010A Calibration feature.

- Fixed issue where there is no message prompted when user selected “Tools-> Infiniium ->
InfiniiSim...” or “Tools-> Infiniium -> PrecisionProbe/PrecisionCable...” feature without
installing the required license.

- Fixed issue where Test 1.1.6 and Test 1.2.9 did not show execution status after test had
completed.

Known issues

- Screenshot timeout issue can happen rarely when running tests.
- Screen might go white during N70T0A Calibration.

- Infinilum might goes in irresponsive when channel hardware differential is turned on with
channel skew in UXR-Series oscilloscope.

7/32 Keysight D9040MPHC MIPI M-PHY Conformance Test Application Release Notes



ANV KEYSIGHT

Keysight D9040MPHC Software Version 02.30.0001

Release Date: June 04, 2019

Requirements category (e.g., operating system): Microsoft Windows 7,
Microsoft Windows 10

Requirements category (e.g., instrument software 06.40.00714 (9000 Series, 90000 Series, 90000 X-
version): Series, 90000 Q-Series, Z-Series),

10.10.04513 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02300001.exe

License: Please see the product data sheet on keysight.com

Miscellaneous Notes
- Updated the product number from “U7249E” to “D9040MPHC” to support PPKS licenses.

Enhancements
- Migrated application to use new graphics user interface environment.
Updated test limit on Test 1.1.9 T_L2L_Skew for “UniPro” and “HS-G4”.

- Added configurable option of “SigTest Template Files” (with remote name of
“SigTestTemplateFiles”) in Configure tab. This configurable option is used to specify the
SigTest Template files to be used when performing SigTest.

- Updated 1.1.7 TEYE_G4 _RT_TX, VDIF_AC_G4 _RT_TX [SigTest] (C) to support new set of
template files for different test cases.

- Added configurable option of “PLL Settling Time (for 2nd Order PLL)” (with remote name of
“SettlingTime”) in Configure tab.

- Updated connection diagram.

Bug Fixes

- Fixed issue on triggering on high data rate signal.

Known issues

- Does NOT support backward compatibility. Project files saved in previous versions will be
available as READ-ONLY. User have to save previous project files as Settings Only before
loading the project in the current software to access all the supported configurations.
[File->Save Project (Settings Only) As...]

- User will experience the increase in the test time when running Test 1.1.6 TEYE, VDIF_AC,
Tests 1.1.7 TEYE_G3, VDIF_AC _G3 and Test 1.1.7 TEYE_G4, VDIF_AC_G4 tests with
N7010A Active Termination Adapter in UXR-Series oscilloscope.

- Screenshot timeout issue can happen rarely when running tests.
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- No message will be prompted when user selected “Tools-> Infinilum -> InfiniiSim...” or
“Tools-> Infiniium -> PrecisionProbe/PrecisionCable...” feature without installing the
required license.

- Export to repository feature where user can export test results to a repository (such as a
database) [File->Export Results...->Repository] is not supported.

- Remote access feature for N7010A is not supported.

Keysight U/7249E Software Version 02.22

Release Date: January 11, 2019

Requirements category (e.g., operating system): Microsoft Windows 7

Requirements category (e.g., instrument software 06.30.00701 (9000 Series)

version): 06.30.00707 (90000 Series, 90000 X-Series, 90000
Q-Series, Z-Series),

10.00.03902 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02220000.exe
License: Please see the product data sheet on keysight.com
Bug Fixes

- Fixed timeout issue on Test 1.1.8 TR_TF when running on UXR-Series oscilloscope.

Known issues

- Inloading projects created in MIPI MPHY version 02.21, users cannot append the existing
results.

- User will experience the increase in the test time when running Test 1.1.6 TEYE, VDIF_AC,
Tests 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4, VDIF_AC_G4 tests with
N70710A Active Termination Adapter in UXR-Series oscilloscope.

- Screenshot timeout issue can happen rarely when running tests.
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Keysight U/249E Software Version 02.21

Release Date: September 27, 2018

Requirements category (e.g., operating system): Microsoft Windows 7

Requirements category (e.g., instrument software 06.30.00517 (9000 Series)

version): 06.30.00517 (90000 Series, 90000 X-Series, 90000
Q@-Series, Z-Series),

10.00.03708 (UXR-Series)

File Name: SetupInfMIPI_M-PHY02210000.exe

License: Please see the product data sheet on keysight.com

New Features

- Supports Infinilum Oscilloscope Software version 10.00 for UXR-Series oscilloscope.

o Added new options (4GSa/s, 8GSa/s, 16GSa/s, 32GSa/s, 64GSa/s, 128GSa/s) for
“Sampling Rate, GSa/s” (with remote name of “SRate”) configurable option in
Configure tab. These options will be available when launching application on UXR-
Series Oscilloscope. The default value is “Default”.

- Added N7010A Active Termination Adapter Calibration feature in Connection Setup form.
The continuous HS signal is required for N7010A calibration. The calibration will be
performed on Primary Test Lane only.

o Added “RSE Method” selection (with remote name of “RSEValueMethod”) in N7010A
Calibration Setup form with the options of “Manual RSE” and “Calculated RSE”. This
option allows user to specify the RSE value manually or auto calculated by application
for N7010A Calibration.

o Added “RSE Value” configurable option (with remote name of
“RSE_ActiveTerminationCal”) in N7010A Calibration Setup form which is only available
if user selected “Manual RSE” for “RSE Method” selection. This option allows user to
specify the RSE value manually.

o Added InfiniiSim selections for TXDP (with remote name of “TXDPInfiniiSimCal”) and
TXDN (with remote name of “TXDNInfiniiSimCal”) signals in N7010A Calibration Setup
form. These options allow user to enable InfiniiSim feature for TXDP and TXDN signals
prior to N7010A Calibration. Added “Transfer Function File” configurable option for
TXDP (with remote name of “TXDPTransferFunctionFileCal”) and TXDN (with remote
name of “TXDNTransferFunctionFileCal”) signals. These options allow user to specify
the transfer function file for embedding/de-embedding.

o Added “N7010A Calibration” configurable option which enable user to find the
appropriate Vterm value. The calculated “Vterm” value and “RSE” value will be
displayed and the Vterm value will be applied for all tests after performing the N7010A
Calibration if user selected “Active Probe (Active Termination Adapter)” for both
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“Probing Method” configurable option. For remote user, this N70T0A Calibration can
be executed remotely by setting “PerformN7010ACalibration” configuration option to
“1.0”.

o Added configurable option of “Interpolation Factor(L2L_SKEW)” in Configure tab which
allows user to specify the interpolation factor to be used when loading waveforms for
Test 1.1.9 T_L2L_SKEW tests.

Added the following new tests to support Test 1.1.7 TEYE_G4, VDIF_AC_G4 testing for HS-
Continuous mode using CTLE and DFE feature from Infiniium. These tests will be enabled if
user selected “v4.0 and v4.1” for configurable option of “CTS”, selected “HS-G4” data rate,
checked “Informative Test” and unchecked “SigTest” Test Method in Set Up tab.

o TestID:1845-1.1.7 TEYE_G4_LA RT_TX, VDIF_AC_G4_LA RT_TX[CH1][0dB] (C)
o TestID: 1846 -1.1.7 TEYE_G4_LA RT_TX, VDIF_AC_G4_LA RT_TX [CH2] [6dB] (C)
o TestID: 1745 -1.1.7 TEYE_G4_SA RT_TX, VDIF_AC_G4_SA RT TX[CH1][3.5dB] (C)

Added “CTLE Setting File” configurable option (with remote name of “CTLESettingFile”) in
Configure tab which enables user to specify the CTLE Setting file to be used when
performing Test 1.1.7 TEYE_G4, VDIF_AC_G4 (C).

Added “CTLE Optimization Criterion” configurable option (with remote name of
“CTLEOptimizationCriterion”) in Configure tab which enables user to specify the criterion
used to determine the optimal CTLE setting among all CTLE setting stated in CTLE Setting
File.

Added “DFE Voltage(V)” configurable option (with remote name of “DFEVoltage”) in
Configure tab which enables user to specify the DFE Voltage to be applied for DFE
equalization.

Added “DFE Eye Diagram Position” configurable option (with remote name of
“DFEEyeDiagramPosition”) in Configure tab which enables user to specify the eye diagram
position after applying DFE equalization.

Added “CTLE Outer Voltage Check Range(V)” configurable option (with remote name of
“CTLEOuterVoltageCheckRange”) in Configure tab which enables user to specify the
voltage range to be applied for CTLE Outer voltage checking where the outer voltage of
eye diagram must within VDIF_AC maximum - (CTLE Outer Voltage Check Range).

Enhancements

Added “Interpolation Factor(L2L_SKEW)” configurable option (with remote name of
“Interpolation_L2LSkew”) in Configure tab which allows user to specify the interpolation
factor to be used when loading waveforms for Test 1.1.9 T_L2L_SKEW tests. By default, it
is set to “OFF”.

Updated the data rate and Ul measurement where the nominal data rate will be
determined by the “Nominal HS Data Rate” in the Setup tab when user selected “Semi-
Automatic” for “Data Rate Mode” in Configure tab. Removed 'Nominal Data rate'
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configurable option (with remote name of “NominalDataRate_fOffset”) from the Configure
tab.

- Added “Transfer Function File (G3)[HS-Continuous Only]” configurable option (with remote
name of “G3ContinuousBEREyeTFFile”) in Configure tab which enables user to disable
reference channel embedding for Test 1.1.7 TEYE_G3, VDIF_AC_G3 (C) tests.

- Added “OFF” option for “Transfer Function File (G4)” configurable option (with remote
name of “G4BEREyeTFFile”) in Configure tab which enables user to disable the reference
channel embedding for Test 1.1.7 TEYE_G4, VDIF_AC_G4 (C) tests.

- Turn off package model embedding in SigTest Tool's template file.

Bug Fixes
- Fixed intermittent unable to measure Unit Interval issue in Test 1.1.1 f_Offset.
- Fixed unable to find SYNC pattern in Test 1.1.9 T_L2L_Skew test.
- Updated PLL Settling Time value from 10mT to 1T for TEYE tests.

- Updated the pass test criteria for Test 1.2.3 TPWM_PREPARE for “CTS v4.0 and v4.1”
option.

- Fixed mask value for Test 1.1.7 TEYE_G3, VDIF_AC_G3.

- Fixed the unit and precision level for “Number of Mask Violation” reporting item for Test
1.1.6 TEYE, VDIF_AC, Test 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4,
VDIF_AC_G4 tests.

- Fixed finding edge algorithm in Test 1.1.5 VDIF_CD to find the correct position of DIF-P
region.

- Fixed issue on the applied template file for Test HS-G4 signal on Test 1.1.7 TEYE_G4,
VDIF_AC_G4[SigTest].

- Fixed description in Connection diagram for burst mode tests.

Known issues

- Inloading projects created in MIPI MPHY version 02.20, users cannot append the existing
results.

- User will experience the increase in the test time when running Test 1.1.6 TEYE, VDIF_AC,
Tests 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4, VDIF_AC_G4 tests with
N7010A Active Termination Adapter in UXR-Series oscilloscope.

- Screenshot timeout issue can happen rarely when running tests.
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Keysight U/249E Software Version 02.20

Release Date: August 22, 2017

Requirements category (e.g., operating system): Microsoft Windows 7

Requirements category (e.g., instrument software 06.00.01001 (90000 Series, 90000 X-Series, 90000
version): Q-Series, Z-Series),

06.00.071001 (9000 Series)

File Name: SetupInfMIPI_M-PHY02200000.exe

License: Please see the product data sheet on keysight.com

Miscellaneous Notes

- Updated product model from “U7249C/U7238D” to “U7249E".

- Updated the license requirements where the MIPI M-PHY 4.1 Upgrade [M4U] or MIPI M-
PHY 4.1 Compliance [MP4] is required to enable CTS “v4.0 and v4.1” option.

U7249C/U7249D MIPI M-PHY compliance test application license (MPH).
U7243E MIPI M-PHY 4.1 Upgrade (M4U).

U72439E MIPI M-PHY 4.1 Compliance (MP4).
Refer to the following table for details:

CTS Version
v3.0 v4.0 and
val
MPH Enabled Disabled
MPH+M4U Enabled Enabled
MP4 Enabled Enabled

Serial Data (SDA) license.
EZJIT Complete (EZP) license.

New Features

- Added “CTS” configurable option (with remote name of “CTSVersion”) in Set Up tab with
the options of “v3.0” and “v4.0 and v4.1”. This option allows user to specify the CTS version
to reflect the available test list accordingly.

- Added support for the following HS-G4 Data Rate to support CTS “v4.0 and v4.1".
HS-G4A (9984)
HS-G4B (11648.0)

(
HS-G4B (11660.8)
HS-G4B (11673.6)

0O O O O
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- Added “MIPI M-PHY Test Limit v4.0 and v4.1” compliance limit set to support CTS “v4.0
and v4.1”. This compliance limit set will be activated if user selected “v4.0 and v4.1” for
configurable option of “CTS”. The test limit for the following tests will be different from CTS
“v3.0”:

Test 1.1.4 VCM
Test 1.1.5 VDIF_DC
Test 1.2.4 VCM
Test 1.2.5 VDIF_DC
Test 1.2.7 VDIF_AC

- Updated the mask value for the following tests to support CTS “v4.0 and v4.17.

Test 1.1.6 TEYE, VDIF_AC (B)
Test 1.1.7 TEYE_GS3, VDIF_AC_G3 (B)
Test 1.1.6 TEYE, VDIF_AC (C)
Test 1.1.7 TEYE_G3, VDIF_AC_G3 (C)

- Updated the following tests as informative tests to support CTS “v4.0 and v4.1".

o O O O O

O
©)
@)
O

Test Name CTSv3.0 CTS v4.0 and v4.1
Test 1.1.8 TR, TF (B) Compliance test Informative test
Test 1.1.14 TPULSE (B) Compliance test Informative test
Test 1.1.6 TEYE, VDIF (B) Compliance test Informative test
Test 1.1.7 TEYE_G3, Compliance test Informative test
VDIF_AC_G3 (B)

- Added configurable option of “SigTest” (with remote name of “TEYESigTestEnable”) in Set
Up tab. This configurable option is used to enable or disable Test 1.1.7 TEYE_G4,
VDIF_AC_G4 [SigTest] tests.

- Added the following new tests to support Test 1.1.7 TEYE_G4, VDIF_AC_G4 testing for HS-
Continuous mode using SigTest Tool. These tests will be enabled if user selected “v4.0 and
v4.1” for configurable option of “CTS”, selected “SigTest” Test Method and “HS-G4” data
rate in Set Up tab.

o TestID: 1843 - 1.1.7 TEYE_G4_LA_RT_TX, VDIF_AC_G4_LA_RT_TX [CH1] [0dB]
[SigTest] (C)

o TestlID: 1844 -1.1.7 TEYE_G4_LA_RT_TX, VDIF_AC_G4_LA_RT_TX [CH2] [6dB]
[SigTest] (C)

o TestID: 1743 -1.1.7 TEYE_G4_SA_RT_TX, VDIF_AC_G4_SA_RT_TX [CH1] [3.5dB]
[SigTest] (C)

- Added configurable option of “Specification Version” (with remote name of
“SpecificationVersion”) in Configure tab with options of “v4.0” and “v4.1”. This configurable
option is used to specify the specification version that determine the targeted BER to be
used for Test 1.1.6 TEYE, VDIF_AC, Test 1.1.7 TEYE_G3, VDIF_AC_G3, Test 1.1.15 TJ, Test
1.1.16 STTJ, Test 1.1.17 DJ and Test 1.1.18 STDJ. This configurable option is only
applicable for CTS “v4.0 and v4.1” selection.
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- Added new test ID and renamed existing tests to support Test 1.1.7 TEYE_G3, VDIF_AC_G3
for HS-Continuous mode to test for three test cases.

Added the following new test:
o TestID: 1823 -1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX [CH2] [6dB] (C)
Renamed the following tests:

o TestID: 1822 -1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX [CH1] [0dB] (C)
[Old Name: 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (C)]

o TestID: 1722 -1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX[CH1] [3.5dB] (C)
[Old Name: 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (C)]

- Added configurable option of “Transfer Function File(G4)” (with remote name of
“G4BEREyeTFFile”) in Configure tab. This configurable option is used to set the transfer
function file that will be embedded when performing Test 1.1.7 TEYE_G4, VDIF_AC_G4
[SigTest] (C).

Enhancements

- Removed “Total Jitter BER Target” (with remote name of “RJDJBER”) configuration option
from Configure tab.

- Renamed “Reference Channel Transfer Function File (G3)” (with remote name of
“BEREyeRefChanTFFile”) configuration option from Configure tab to “Reference Channel
Transfer Function File (G3)[HS-Burst Only]”.

- Moved “Protocol Specification” (with remote name of “ProtocolSpecificationL.2L”)
configuration option from Configure tab to Set Up tab. Added “M-PCle” protocol
specification for CTS “v4.0 and v4.1” selection. The test availability and test limit of Test
1.1.9 HS-TX Lane-to-Lane Skew and Test 1.2.9 PWM-TX Lane-to-Lane Skew tests will be
changed based on the “Protocol Specification” selection.

- Reported mask violation value for all three regions in Test 1.2.6 TEYE test.

Bug Fixes
- Fixed timeout issue in Test 1.1.9.

- Renamed “Data Rate Mode[f_Offset]” (with remote name of “DataRateMode_fOffset”) and
“Nominal Data Rate[f_Offset]” (with remote name of “NominalDataRate_fOffset”)
configuration option to “Data Rate Mode” and “Nominal Data Rate”. Corrected description
for these configuration options.

Known issues

- Inloading projects created in MIPI MPHY version 02.13, users cannot append the existing
results.
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Keysight U/249C\U7/249D Software Version 02.13

Release Date: March 24, 2017

Requirements category (e.g., operating system): Microsoft Windows 7

Requirements category (e.g., instrument software 06.00.00602 (90000 Series, 90000 X-Series, 90000
version): Q-Series, Z-Series),

06.00.00602 (9000 Series)

File Name: SetupInfMIPI_M-PHY02130000.exe
License: Please see the product data sheet on keysight.com
Enhancements
- Updated Test 1.1.2 PSDCM test to use wrapper and matlab for plotting Power Spectral
Density graph.
Bug Fixes

- Removed horizontal scale setting on differential function.
- Updated to display a proper message when test is cancelled by user.

- Fixed sequence issue on Test 1.1.6 TEYE.

Known issues

- Inloading projects created in MIPI MPHY version 02.11, users cannot append the existing
results.
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Keysight U7249C\U7249D Software Version 02.11

Release Date: December 02, 2016

Requirements category (e.g., operating system): Microsoft Windows 7

Requirements category (e.g., instrument software 5.70.00715 (90000 Series, 90000 X-Series, 90000
version): Q-Series, Z-Series),

5.70.00715 (9000 Series)

File Name: SetupInfMIPI_M-PHY02110000.exe

License: Please see the product data sheet on keysight.com

New Features

- Enabled “Disable Infinilum user interface during run” feature.

Enhancements

- Added enhancement to check and display error message if the number of copies of pattern
found is insufficient for processing for Test 1.1.8 TR_TF_HS_TX.

Bug Fixes
- N/A

Known issues

- Inloading projects created in MIPI MPHY version 02.10, users cannot append the existing
results.
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Keysight U7249C\U7249D Software Version 02.10

Release Date: April 05, 2016

Requirements category (e.g., operating system): Microsoft Windows 7

Requirements category (e.g., instrument software 5.60 (90000 Series, 90000 X-Series, 90000 Q-
version): Series, Z-Series),

5.60 (9000 Series)

File Name: SetupInfMIPI_M-PHY02100000.exe

License: Please see the product data sheet on keysight.com

Miscellaneous Notes

- Rebranding U7249C\U7249D MIPI M-PHY Conformance Test Application under Keysight
Technologies.

New Features

- Support for Active Termination Adapter (N7010A). The minimum supported Infiniium
version for this feature is Infiniium v5.50.0006.

- Added new option of “Active Probe (Active Termination Adapter)” and “Active Probe (Active
Termination Adapter)[Manual]” for both “Probing Method-No switch” (with remote name of
“Probing Method”) and “Probing Method-with switch” (with remote name of
“SwitchMatrixProbeMethod”) configuration options in Connection Setup form to support
Active Termination Adapter (N7010A).

- These options are applicable for Active Termination Adapter (N7010A) usage only. The
measurement algorithm of Test 1.1.4 VCM (B) and Test 1.2.4 VCM tests is dependent on
probing method setting.

- For “Active Probe (Active Termination Adapter)” probing method, the Vterm value is set to
OV for all tests except Test 1.1.4VCM(B) and Test 1.2.4 VCM tests. For Test 1.1.4 VCM(B)
and Test 1.2.4 VCM tests, the Vterm value will be computed during these tests and only
apply for these tests.

- For “Active Probe (Active Termination Adapter)[Manual]” probing method, user will need to
configure the Vterm value using Infiniium’s Probe Configuration dialog box before running
tests. The configured Vterm value is apply for all tests.

- Added new test IDs for 1.1.4 VCM (B) and 1.2.4 VCM tests to support ““Active Probe
(Active Termination Adapter)” probing method.

HS-Burst Maode:
o TestID: 834, 734
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LS-PWM Mode:
o TestID: 434, 334, 234, 134

- Added new test IDs for 1.1.4 VCM (B) and 1.2.4 VCM tests to support “Active Probe (Active
Termination Adapter[Manual]” probing method.

HS-Burst Mode:

o TestID: 835, 735

LS-PWM Mode:

o TestID: 435, 335, 235, 135

- Added “Interpolation Factor” (with remote name of “PWM_TEYEInterpolationFactor”)
configuration option. This option is used to specify the interpolation factor to be used when
loading waveform file for eye diagram generation. This option is only application for Test
1.2.6 TEYE and Test 1.2.7 VDIF_AC tests.

- Added “Data Rate Mode[f_Offset]” (with remote name of “DataRateMode_fOffset”)
configuration option. This option is used to specify the data rate mode used for Unit
Interval measurement in Test 1.1.1 f_Offset.

- Added “Nominal Data Rate[f_Offset]” (with remote name of “NominalDataRate_fOffset”)
configuration option. This option is used to specify the nominal data rate used for Unit
Interval measurement in Test 1.1.1 f_Offset. This config is only applicable if the user
selected "Semi-Automatic" for "Data Rate Mode[f_Offset]" configuration option.

Modifications

- Updated the choice of “Probing Method-No switch” (with remote name of “Probing
Method”) configurable option in Connection Setup form. The choice of “Active Probe” was
updated to “Active Probe (Differential Probe)”.

- Move “Switch Matrix Data Lane Probing Method” (with remote name of
“SwitchMatrixProbeMethod”) configurable option from Configure tab to Connection Setup
form in Set Up tab. This option is named as “Probing Method-with switch”. Updated the
choices to “Active Probe (Differential Probe)” and “Direct Connect” from “DiffProbe” and
“SMA”.

- Updated Test 1.1.7 TEYE-G3-TX, VDIF-G3-TX tests as informative tests for HS-G3A data
rate selection.

Test ID: 802 - 1.1.7 TEYE_G3_LA RT_TX, VDIF_AC_G3_LA_RT_TX (B)
Test ID: 702 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA RT_TX (B)
Test ID: 1822 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (C)
Test ID: 1722-1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (C)

- Updated Test 1.2.6 TEYE-TX tests as informative tests.

o TestID:401-1.2.6 TEYE_LA RT_TX
o TestID:301-1.2.6 TEYE_SA_RT_TX
o TestID: 201 -1.2.6 TEYE_LA_NT_TX

O O O O
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o TestID: 101 -1.2.6 TEYE_SA_NT_TX

- Updated Test 1.2.8 TR_TF-PWM-TX tests to run Test 1.2.1TTPWM-TX test as pre-requisite
test. The TPWM-TX value measured from Test 1.2.1 will be used to calculate the dynamic
limit for Test 1.2.8.

- Updated the label of “HS Data Rate [Mbps]” to “Nominal HS Data Rate [Mbps]” in Setup
tab.

- Updated the vertical offset value of the differential waveform to OV for Test 1.1.6 TEYE(C)
and Test 1.1.7 TEYE_G3(C) tests.

Bug Fixes

- Fixed issue on 1.2.1 TPWM-TX(MIN) test where the algorithm is unable to find correct
falling edges to calculate the TPWM.

- Fixed issue on 1.1.2 PSDCM test.

- Fixed issue on SerialPatternFinderMPHY User-Defined function. Use OV as middle
threshold to identify edges.

- Fixed histogram data streaming issue on 1.1.6 TEYE test.

- Fixed issue on ButterMPHYfilter User-Defined function. The number of Ul transition for test
signal will be checked before applying ButterMPHYfilter User-Defined function.

- Fixed issue on Test 1.2.7 VDIF_AC where there is no histogram hits within histogram
window. Updated the application to load waveform file with interpolation (INT16) to resolve
the issue.

- Fixed triggering issue where application unable to trigger signal with data rate >4Gbps
that doesn’t have positive pulse width >250ps. Changed triggering method to edge trigger
for HS-Continuous signal type.

- Fixed issue on Test 1.2.6 TEYE test where the measurement result is not converted to Ul
unit correctly if “AUTO” PWM Gear is selected.

Known issues

- Inloading projects created in MIPI MPHY version 02.02, users cannot append the existing
results.
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Agilent U7249C\U7249D Software Version 02.02

Release Date: March 05, 2015

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7

Requirements category (e.g., instrument software 4.20 (9000 Series, 90000 Series, 90000 X-Series)

version):
File Name: SetupInfMIPI_M-PHY02020000.exe
License: Please see the product data sheet on keysight.com

Miscellaneous Notes

- This will be the last version to support Infiniium Oscilloscope Baseline Version 4.20.

New Features

- Added new test IDs to support eye mask test at far-end TX probing point. These tests are
added as informative tests. The RX eye mask is applied in these tests.

HS-Burst Mode:
o LA_RT Test Group

= TestID: 841 -1.1.6 TEYE_LA RT_TX, VDIF_AC_LA_RT TX [Far End HS-RX Test
Point] (B)

»  TestID: 842 -1.1.7 TEYE_G3_LA_RT TX, VDIF_AC_G3_LA RT_TX [Far End HS-RX
Test Point] (B)

o SA_RT Test Group

= TestID: 741 -1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA RT_TX [Far End HS-RX Test
Point] (B)
= TestID: 742 -1.1.7 TEYE_G3_SA_RT TX, VDIF_AC_G3_SA RT_TX [Far End HS-RX
Test Point] (B)
HS-Continuous Mode:
o LA_RT Test Group

» TestID: 18471 -1.1.6 TEYE_LA RT_TX, VDIF_AC_LA_RT_TX [Far End HS-RX Test
Point] (C)

= TestID: 1842 -1.1.7 TEYE_G3_LA RT TX, VDIF_AC_G3_LA_RT_TX [Far End HS-RX
Test Point] (C)

o SA_RT Test Group

» TestID: 1741 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX [Far End HS-RX Test
Point] (C)

s TestID: 1742 -1.1.7 TEYE_G3_SA RT TX, VDIF_AC_G3_SA_RT TX [Far End HS-RX
Test Point] (C)
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- Added the configuration option “Total Acquisition Length [UI]” (with remote name of
“TotalBEREyeAcglen”) in Configure tab.

Modifications

- Updated the “DUTDataRate” configuration option where it will not accept any “user-
defined text” through remote.

- Updated the choices of “Scope Bandwidth” configuration option.
- Updated the test algorithm for the following tests to comply with MIPI MPHY CTS v3.0r17.
HS-Burst Mode:
o LA_RT Test Group
» TestID: 801 - 1.1.6 TEYE_LA_RT_TX, VDIF_AC_LA_RT_TX (B)
» TestID:802-1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (B)
o SA_RT Test Group:
» TestID: 701 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX (B)
» TestID: 702 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (B)
HS-Continuous Mode:
o LA_RT Test Group
» TestID: 1821 - 1.1.6 TEYE_LA_RT_TX, VDIF_AC_LA_RT_TX (C)
» TestID: 1822 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (C)
o SA_RT Test Group:
» TestID: 1721 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX (C)
» TestID: 1722-1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (C)

- Removed the following tests IDs from the application.
HS-Burst Mode:

o TestID: 1801 - 1.1.6 TEYE_LA_RT_TX (B)
o TestID: 1802 -1.1.7 VDIF_AC_LA_RT_TX (B)

HS-Continuous Mode:
o TestID: 1701 - 1.1.6 TEYE_LA RT TX (C)
o TestID:1702- 1.1.7 VDIF_AC_LA RT TX (C)

- Updated Test 1.1.2 PSDCM-TX, Test 1.1.15 TJ-TX, Test 1.1.16 STTJ-TX, Test 1.1.17 DJ-TX
and Test 1.1.18 STDJ-TX tests as Informative tests.

HS-Burst Mode:
o LA_RT Test Group:
» TestID:816-1.1.2 PSDCM_LA_RT_TX (B)
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o SA_RT Test Group:

» TestID: 716 - 1.1.2 PSDCM_SA_RT_TX (B)
HS-Continuous Mode:
o LA_RT Test Group:
TestID: 1812 - 1.1.15 TU_LA_RT_TX (C)
Test ID: 1814 - 1.1.16 STTJ_LA_RT_TX (C)
Test ID: 1813 - 1.1.17 DJ_LA_RT_TX (C)
Test ID: 1815 - 1.1.18 STDJ_LA_RT_TX (C)
o SA_RT Test Group:

= TestID:1712-1.1.15 TJ_SA_RT_TX (C)

» TestID: 1714 -1.1.16 STTJ_SA_RT_TX (C)

= TestID:1713-1.1.17 DJ_SA_RT_TX (C)

» TestID: 1715 -1.1.18 STDJ_SA_RT_TX (C)

- Removed the following configuration options from the application.

Label Configuration option
RJ Method BEREyeRJMethod
RJ Bandwidth RJBandwidth
Total Jitter BER Target NoiseBER
Pattern Repetition NoisePatternLength
Non-Periodic Pattern Filter Lead NoiseFilterLead
Non-Periodic Pattern Filter Lag NoiseFilterLag
Single Acquisition Length [Ul] BEREyeAcglLen

Bug Fixes
- Fixed remote programming issue.
- Fixed InfiniiSim related bug in the application

- Corrected the typo label of “Secondly” to “Secondary” on Connection Setup Form.

Known issues

- Inloading projects created in MIPI MPHY version 02.01, users cannot append the existing
results.
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Agilent U7249C\U7/2439D Software Version 02.01

Release Date: September 26, 2014

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7

Requirements category (e.g., instrument software 4.20 (9000 Series, 90000 Series, 90000 X-Series)

version):
File Name: SetupInfMIPI_M-PHY02010000.exe
License: Please see the product data sheet on keysight.com

New Features
- Added “Active Probe” and “Direct Connect” probing method options.
- Added 1.2.3 TPWM-PREPARE Length test under LS-PWM Mode.

- Added “Optical Media Converter(OMC)”, “TX_LS_PREPARE_LENGTH”, “MC_LS_PREPARE
LENGTH” and “TLINE_RESET_DETECT” configuration options. These options are used for
1.2.3 TPWN-PREPARE Length test.

- Added “VDIF_AC Histogram Window” configuration option. This option is used to specify
the location of histogram window for 1.2.7 VDIF_AC test under LS-PWM Mode.

- Support for multiple test groups(LA_RT, SA_RT, LA_NT, SA_NT) selection in single trial.

- Added “Number of 0011 and 1100 patterns” configuration option. This option is used to
select the number of rise/fall time measurement.

- Added “Interpolation” configuration option. This option is used to enable/disable the
interpolation feature for 1.1.8 TRTF test and 1.1.10 SR_DIF test.

- Added 1.2.9T _L2L Skew test under LS-PWM Mode.

Modifications
- Update eye mask for HS-G3 in 1.1.6 TEYE test.
- Update 1.1.3 HS-PREPARE Length test algorithm.

- Update 1.1.8 TRTF test algorithm to perform rise time and fall time measurement on 0011
and 1100 patterns, respectively.

- Update 1.1.10 SR_DIF test algorithm to perform rise time measurement on 0011 pattern
only.

- Unify connection setting for all tests.

- Move “Connection Setup” to Set Up tab.

- Update 1.2.7 VDIF_AC test algorithm to perform VDIF_AC measurement on all PWM bits.
- Update test limit of 1.1.3 HS-PREPARE Length test.
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Bug Fixes
- Fixed issue where the application crash when user selected more than one data lane.
- Fixed mask test issue for 1.1.6 TEYE test.

Known issues

- Inloading projects created in MIPI MPHY version 02.00, users cannot append the existing
results.
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Agilent U7249C\U7/243D Software Version 02.00

Release Date: May 30, 2014

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7

Requirements category (e.g., instrument software 4.20 (9000 Series, 90000 Series, 90000 X-Series)

version):
File Name: SetupInfMIPI_M-PHY02000000.exe
License: Please see the product data sheet on keysight.com

New Features

- Added 1.1.3 HS-PREPARE Length test under HS- Burst Mode.

- Added “TX_HS_PREPARE_LENGTH” configuration option under HS Burst Data mode. This
option is used to define the test limit for the test.

- Added 1.1.6 TEYE (BER 1E-10) and 1.1.6 TEYE_G3 (BER 1E-10) tests under HS-
Continuous Mode.

- Added 1.1.9 Lane-to-Lane Skew test under HS- Burst Mode.

- Added “Protocol Specification” and “Test Limit for DigRFv4 Protocol Specification”
configuration options for Lane-to-lane Skew test under HS Burst Data mode. These
options are used to define the test limit for the test.

- Added 1.1.1 Unit Interval and Frequency Offset [MAX] and 1.1.1 Unit Interval and
Frequency Offset [MIN] tests.

- Added 1.2.1 PWM-TX Transmit Bit Duration (TPWM) [MAX] and 1.2.1 PWM-TX Transmit
Bit Duration (TPWM) [MIN] tests.

- Added 1.2.2 PWM-TX Transmit Ratio (kPWM) [MAX] and 1.2.2 PWM-TX Transmit Ratio
(kPWM) [MIN] tests.

- Split 1.2.10 PWM-TX Transmit Bit Duration Tolerance(TOLPWM) test to TOLPWM [MAX]
and TOLPWM [MIN] tests.

- Split 1.2.10 TOLPWM-G1 test to TOLPWM-G1 [MAX] and TOLPWM-G1 [MIN] tests.

- Added “TrigThresholdMode” and “Trigger Level” configuration options. These options are
used to specify the trigger threshold mode and trigger level.

- Added “Trigger Location” configuration option to set the starting location of the trigger.

- Added “SYNC Pattern” configuration option under HS Burst Data mode for additional M-
PHY SYNC Pattern searching.

- Added “Logger” configuration option for DJ and STDJ tests under HS-Burst Mode. This
option is used to enable/disable the feature to save all waveforms and results for the test.
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- Added “Transition Density Dependent” configuration option for TEYE and VDIF_AC tests
under HS Burst mode. This option is used to enable/disable the transition dependent
density feature.

- Added “Sampling Rate” configuration option. This option is used to allow Sampling Rate
selection.

- Added “Save Waveforms” configuration option for Slew Rate test. This option is used to
enable/disable the feature to save all waveforms for the test.

- Added “RSE_TX” configuration option for Vcm test.

- Added “RJ Bandwidth” configuration option for 1.1.6 TEYE_G3 under BER EYE Opening
Test Settings. This option is used to allow RJ Bandwidth selection.

- Added “RJ Method” configuration option.

Modifications

- Update MPHY app to apply 1.1.1 HS-TX Unit Interval and Frequency Offset test as
prerequisite test for any other tests that reference the UIHS measured from this test.

- Update Slew Rate test algorithm to process rising edges only instead of all edges.

- Change default value of “Acquisition length” under Jitter Test Setting to 250000 UI.

- Update tests labels for all tests under HS-Burst Mode and HS-Continuous Mode.

- Update Slew Rate tests for Gear 2 and Gear 3 as Informative test.

- Update 1.1.8 Rise and Fall times test under HS-Continuous Mode as Informative test.

- Update 1.1.17 DJ and 1.1.8 STDJ tests under HS-Burst Mode as Informative test.

- Update all Jitter tests to use “JTF” options instead of “OJTF” options.

- Applied TIE filter for 1.1.17 DJ and 1.1.8 STDJ tests under HS-Burst Mode.

- Update MPHY app to support SYNC pattern searching according to MPHY specification.

- Reorganize the configuration setting for better usability and identification of HS-Burst
Mode and HS-Continuous Mode related tests.

- Update 1.1.1 Unit Interval and Frequency Offset test to compliance with MIPI MPHY CTS

v3.0r12.

- Update MPHY app to save waveforms separately for HS-Burst, HS-Continuous, PWM
Modes.

- Update 1.1.5 VDIF_DC(HS) and 1.2.5 VDIF_DC(PWM) tests’ algorithm to support signal
with long DIF-N.

- Update 1.2.1 TPWM and 1.2.2 kPWM tests to compliance with MPHY MIPI MPHY CTS
v3.0r12.

- Change default value of “Pattern repetition” configuration option to “Periodic”.
- This option is applicable for all TJ, DJ tests in HS-Continuous Mode.

- Turn on interpolation for Slew Rate tests.
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Update 1.1.13 Intra-Lane Output Skew test algorithm to remove the need of using
“SkewedHalfUl” saved waveform.

- Update the clock recovery method for 1.1.18 STTJ test under HS-Continuous Mode.

- Update 1.1.4 Vem (HS) and 1.2.4 Vem (PWM) tests’ algorithm to cater for RSE_TX
tolerance in Vcm measurement.

- Update all tests that do not have explicit specified measurement threshold method in CTS
to use the “Hysteresis” measurement threshold method.

- Disable the “HS Data Eye Filter” to include SYNC region for 1.1.6 TEYE and 1.1.7 VDIF_AC
tests under HS-Burst Mode.

- Move “Number of Slew Rate State” configuration option to Setup Page.

- Masked off Slew Rate tests when “1” is selected for “Number of Slew Rate State”
configuration option.

- Supports for Infiniium Oscilloscope Software version 5.00.

Bug Fixes
- Fixed issue in Vcm tests by reporting mean value of Vem measured as final test result.
- Fixed issue in Slew Rate test where the test cannot be cancelled by user.
- Fixed connection diagram issue.
- Fixed bug in PSDCM test where it should be masked off for differential connection type.
- Fixed scaling issue.

- Fixed TEYE and VDIF_AC test issue where no enough data for histogram measurement on
Eye diagram generated.

Known issues

- Inloading projects created in MIPI MPHY version 01.11, users cannot append the existing
results.
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Agilent U7249A Software Version 01.10

Release Date: November 25, 2013

Requirements category (e.g., operating system): Microsoft Windows XP

Requirements category (e.g., instrument software 3.11 (9000 Series, 90000 Series)

version):
File Name: SetupInfMIPI_M-PHY01100000.exe
License: Please see the product data sheet on keysight.com

New Features

- New tests added under LS:PWM Signal Type to support all Test Group configuration
options(LA_RT, SA_RT, LA_NT, SA_NT):

LA_RT Test Group:

@)

Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:

0406 - 1.2.1 TPWM-TX_LA RT_TX

0408 - 1.2.2 kPWM-TX_LA RT_TX

0403 - 1.2.4 VCM_LA_RT_TX

0400 - 1.2.5 VDIF_DC_LA RT_TX

0401 - 1.2.6 TEYE_LA_RT_TX

0402 - 1.2.7 VDIF_AC_LA_RT_TX

0404 - 1.2.8 TR_TF_PWM_LA_RT_TX

0417 - 1.2.10 TOLPWM-TX_LA RT_TX

0407 - 1.2.10 TOLPWM-GT-TX_LA_RT_TX
0409 - 1.2.11 TPWM-MINOR-GO-TX_LA RT_TX

For SA_RT Test Group:

Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:
Test ID:

0306 - 1.2.1 TPWM-TX_SA_RT_TX

0308 - 1.2.2 kPWM-TX_SA_RT_TX

0303 - 1.2.4 VCM_SA_RT_TX

0300 - 1.2.5 VDIF_DC_SA _RT_TX

0301 - 1.2.6 TEYE_SA_RT_TX

0302 - 1.2.7 VDIF_AC_SA_RT_TX

0304 - 1.2.8 TR_TF_PWM_SA_RT_TX

0307 - 1.2.10 TOLPWM-GT-TX_SA_RT_TX
0309 - 1.2.11 TPWM-MINOR-GO-TX_SA_RT_TX
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o For LA_NT Test Group:

= TestID: 0206 - 1.2.1 TPWM-TX_LA_NT_TX

» TestID: 0208 - 1.2.2 kPWM-TX_LA_NT_TX

= TestID: 0203 - 1.2.4 VCM_LA NT_TX

= TestID: 0200 - 1.2.5 VDIF_DC_LA_NT_TX

» TestID: 02071 - 1.2.6 TEYE_LA_NT_TX

= TestID: 0202 - 1.2.7 VDIF_AC_LA_NT_TX

» TestID: 0204 - 1.2.8 TR_TF_PWM_LA_NT_TX

= TestID: 0207 - 1.2.10 TOLPWM-GT-TX_LA_NT_TX

» TestID: 0209 - 1.2.11 TPWM-MINOR-GO-TX_LA_NT_TX
o For SA_NT Test Group:

» TestID: 0106 - 1.2.1 TPWM-TX_SA_NT_TX

= TestID: 0108 - 1.2.2 kPWM-TX_SA_NT_TX

= TestID: 0103 -1.2.4 VCM_SA_NT_TX

= TestID: 0100 - 1.2.5 VDIF_DC_SA_NT_TX

= TestID: 0101 - 1.2.6 TEYE_SA_NT_TX

» TestID:0102 -1.2.7 VDIF_AC_SA_NT_TX

» TestID: 0104 - 1.2.8 TR_TF_PWM_SA _NT_TX

= TestID: 0107 - 1.2.10 TOLPWM-GT1-TX_SA_NT_TX

= TestID: 0109 - 1.2.11 TPWM-MINOR-GO-TX_SA_NT_TX

- Added “MaxNumOfAcq” and “Acquisition length [Ul]” configuration option for TJ and DJ
jitter measurements under HS Continuous Data mode.

- Added “IntraSkewEdgeHysteresis” configuration option. This option is used to set the
measurement thresholds when performing the Intra-Lane Output Skew test.

- Added “HS Data Eye Filter” configuration option where user can enable/disable HS Data
Eye filtering when performing the HS Burst data tests

- Added “PWM Data Eye Filter” configuration option where user can enable/disable PWM
Data Eye filtering when performing the PWM tests.

- Support HS Continuous Data mode testing.
- Support “Switch Matrix” feature.

Modifications
- Removed the “Offline Mode” feature from the setup tab.

- Renamed the Signal Type label from “High Speed” to “HS-Burst” and “PWM” to
“LS:PWM”. In addition, the “HS-Continuous” mode is added to the Signal Type options.
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- Removed test ID:405 from the application as this test is not found in the CTS for PWM test
group.
- Update all tests as per MPHY MIPI MPHY CTS v1.00.

- Updated the HS IntraSkew test algorithm to perform edge-to-edge measurement instead
of using eye diagram method.

- Changed the default value of the “TestPatternLength” from “3584” to “1320”.

- Removed the “GEAR and RATE” option (with remote name of “HSDataRate”) in the
Configure Tab of the application. This option is replaced by a new configurable option in
the Setup Tab of the application, namely “HS Data Rate” (with remote name of
“DUTDataRate” ). This option is applicable for all “High Speed” Signal Type option. For

the “Low Speed” Signal Type option, the related configuration is “PWM Gear” (with remote
name of “DUTPWMGear”).

- Due to a data model change in migration to a new framework platform, the entire legacy
saved project will be loaded as READ-ONLY for viewing purposes. User will not be able to
append new test results to the legacy saved projects.

- The “Hysteresis method” measurement threshold is used when performing all the test
measurements (that does NOT have explicit specified measurement threshold method in
the CTS specifications). User can use the “Hysteresis Range” and “Hysteresis Level”
configuration option to set custom measurement threshold settings.

- Updated all HS CDR related tests to use a measured data rate value.

- AL HS Continuous Data tests has been updated to use maximum sample rate and
interpolation is enabled.

- Updated connection diagram for all HS tests.

- Added additional HS Data Rate value options that are referenced from UFS specifications
in the Setup tab.

Bug Fixes

- Resolved the issue where some of user configuration options are not loaded correctly
when using saved project file.

- Corrected the typo label of “DIP-P” to “DIF-P” for test reporting in common mode test.
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Agilent U7249A Software Version 01.00

Release Date: September 16, 2011

Requirements category (e.g., operating system): Microsoft Windows XP

Requirements category (e.g., instrument software 3.11 (9000 Series, 90000 Series)

version):
File Name: SetupInfMIPI_M-PHY01000000.exe
License: Please see the product data sheet on keysight.com

Initial Release

Miscellaneous Notes

- Initial release will consist of 12 HS tests supporting Gear 1, 2 and 3 based on MIPI MPHY
CTS v0.65.
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